DeviceNet

Option Board
for SV-iP5A Series

Read this manual carefully before using the PROFIBUS-DP

Option board and follow the instructions exactly.

After reading this manual, keep it at handy for future

LS Industrial Systems







Thank you for purchase of LS DeviceNet Option Board!

SAFETY PRECAUTIONS

® Always follow safety precautions to prevent accidents and potential hazards from

occurring.
® Safety precautions are classified into “WARNING” and “CAUTION” in this manual.

Indicates a potentially hazardous situation

& WARN I NG which, if not avoided, can result in serious injury
& CAUTION Indicates a potentially hazardous situation which,

if not avoided, can result in minor to moderate
injury, or serious damage to the product.

® Throughout this manual we use the following two illustrations to make you aware of

safety considerations:

C Identifies potential hazards under certain conditions.
Read the message and follow the instructions carefully.

C Identifies shock hazards under certain conditions.
Particular attention should be directed because dangerous voltage may

be present.

® Keep this manual at handy for quick reference.

/\ CAUTION

® Be sure to take ESD (Electrostatic Discharge) protection measures when you
touch the board.
Otherwise, the option board may get damaged due to static charges.

® Implement wiring change on the Option Board after checking that
the power supply is off.




Otherwise, there is a danger of connecting error and damage to the board.
Be sure to fix inverter to option board tightly.

Otherwise, there is a danger of connecting error and damage to the board.
Be sure to install a termination resistor (120ohm, 1/4W) at the end of the
network.

Be sure to check parameter unit when setting parameters.
Otherwise, there is a danger of connecting error.



CHAPTER 1 - INTRODUCTION

By using a DeviceNet communication board, SV-iP5A inverter can be connected to a

DeviceNet network.
Through LS DeviceNet Option Board...

1.1.

Inverter can be controlled and monitored by PLC sequence program or any
Master Module.

Multiple inverters can be connected to one communication cable with
simple and easy installation, dramatically saving wiring, maintenance cost
and time.

Compatible with PC System, PLC and any controllers is available, making
Factory Automation more easily.

1.1.1. Vocabulary

In this manual we refer to the:

1.2.

1.3.

DeviceNet Option Board for iP5A series as the Option Board

iP5A series inverter as the inverter

Kit Contents

The DeviceNet option board kit consists of:

DeviceNet Option Board, 1 pcs
5 pin Connector, 1 pcs
Mounting poles, 3 pcs
Installation Manual

DeviceNet Option Board Specification

Device Type: AC Drives

Explicit Peer to Peer Messaging: Support

I/O Peer to Peer Messaging: N/A (Not Available)
Configuration Consistency Value: N/A

Faulted Node Recovery (Off-Line): Support
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® Baud Rate Support: 125, 250, 500 (kbps)

Master/Scanner (Predefined M/S Connection): Support

® |/O Slave Messaging

- Polling: Su
- Bit Strobe,

pport
Cyclic, COS (Change of State): N/A

® Range of Input Voltages: 11 — 25V DC

1.4. Installing the Communication Card

1.4.1. Board Layout
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Figure 1 — Board layout
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MS
(Module Status) LED

Checks the status of incoming power to option
board, CPU function and communication to the

Inverter.

NS
(Network Status) LED

Checks the connection of option card on the
Network and DeviceNet power status.

Note) Refer to Chapter 4 - TROUBLESHOOTING for more details.




1.4.3. DeviceNet Connection Terminal

DeviceNet Terminal | Signal Function Cable Color
Terminal Block
1 Common | Common Black
1 2 3 4 5 2 CAN Low | Signal Low Blue
(Booo @U 3 Shield Shield Bare
4 CAN High | Signal High White
5 V+ Power supply [Red

(11-24VDC)

Figure 2 — DeviceNet Terminal Block



CHAPTER 2 - INSTALLING THE OPTION BOARD

2.1. Installing the Option Board to the Inverter

Figure 3 — Installing the DeviceNet Board to the Inverter

2.1.1. Setting the DeviceNet Parameter

2.1.1.1. Setting the MAC ID <COM Group, #10>

1. MAC ID (Media Access Control Identifier) is a unique value to identify nodes in the
DeviceNet Network. When setting, you must ensure that the each serial device on
the network has a unique address.

2. Setting and changing MAC ID is available via keypad.

3. The factory default setting is DeviceNet address 63. If DPRAM communication
between Inverter and the Option card becomes faulty, the value will default to
Station Number 63.



4.

Min Value Max Value Parameter Setting
MAC ID 0 63 COM Group, #10

When MAC ID is changed during Run, Option board is automatically reset to find
the device new MAC ID is allocated on the network. If a duplicate Mac ID is
checked, NS (Network Status) LED turns Solid Red. In this case, it should be
changed to different MAC ID. In the normal operation, LED color is flashing Green.

2.1.1.2. Setting the Baud Rate < COM Group, #11>

1.

Baud Trunk Cable Length Drop Length

Rate Thick Cable | Thin Cable | Max Length Total
125 500 m 156 m
kbps (1640 ft.) (512 ft.)
250 250 m 100 m 78 m

6 m (20 ft.)

kbps (820 ft.) (328 ft.) (256 ft.)
500 100 m 39m
kbps (328 ft.) (128ft.)

Table 1 — Baud Rate vs. Cable Length

The Baud Rate determines the maximum length of the DeviceNet cable. Refer to
Table 1 to determine cable lengths and baud rates. The above is only met when
DeviceNet-dedicated cables are used. For more information on the DeviceNet
cables, makers and detail specifications, refer to the Open DeviceNet Vendor
Association (ODVA) homepage at “http://www.odva.org/”.

NS LED remains OFF when the setting of actual Network communication speed and

Baud Rate does not match.
Set the desirable Baud Rate via Keypad. Changing this parameter does not change
the actual data rate until power is cycled. Reset the inverter or request Reset



Service to the Inverter Reset Identity Object.
4. NS LED will turn to flashing Green when Network Baud Rate matches Baud Rate of
the option card and a unique MAC ID is allocated.

2.1.1.3. Setting Assembly Instance
Assembly Instance has four types of Sending/Receiving data through Poll I/O
communication. Refer to Assembly Object in Chapter 7 for detailed information.

2.2. Setting Other Parameters

2.2.1. Setting Option Mode [COM Group, #02]

Via DeviceNet COM Group, #02 setting
Issuing Operating command only Command

Issuing Frequency command only Freq

Issuing Operating + Frequency command Cmd+Freq

Table 2 — Setting Option Mode
Note) This setting supercedes setting in FU1 group.

2.2.2. Setting TimeOut [1/0, #49]

The factory default setting for TimeOut is 1 sec. When communication between inverter
and DeviceNet network is disrupted in the Run mode, inverter checks the communication
failure and performs operation under the setting in I/O group #48 until Master-setting
Time + preset TimeOut elapses.

2.3. Poll I/O Connection

It is a Data transaction between Inverter and Scanner.

® Input/output size: 4 bytes
® Communication Rate: 0 (default)
® Data Transaction: Poll I/O



Data transaction thru Poll I/O is determined by the setting of Assembly Instance [COM,
#12,13].

Assembly Instance consists of Input and Output, based on Scanner side. Therefore,
Input Data means data Scanner receives. For inverter side, it is the feedback value to

Scanner.
By contrast, Output Data is the data Scanner transmits to the Inverter as a new

command.
Output Assembly
Scanner "
(Ex:PLC) ) Inverter
" Input Assembly
Figure 4 - Data Transaction via Poll /O Communication
Scanner Side Inverter Side
Input Assembly Data Receive data Transmit data
Output Assembly Data Transmit data Receive data




CHAPTER 3 - MODES OF OPERATION

3.1. PowerUp Reset mode

During a powerup or reset, the option board:

1. Performs powerup initialization. First Module Status LED flashes Green for
0.25sec to Red for 0.25sec and then turns to Solid Green when DPRAM is in
normal operation.

2. Then, Network Status LED flashes Green for 0.25sec to Red for 0.25sec

3. After no duplicate MAC ID is detected, Network Status LED flashes Green,
indicating the option board is successfully connected to the Network. However,
communication with other nodes has not been initiated.

If the above steps is failed, follow the below steps. No action is required in the normal
operating state.

1. When DPRAM is not working properly, Module Status LED turns Solid Red. In
this case, Check the option board’s connection with Inverter first and cycle the
power.

2. When NS remains OFF, not flashing Green,

1) Check the DeviceNet Power
2) Check the Baud Rate of Network and the Option board matches.

® When duplicate MAC ID error occurs, Network Status LED turns Solid Red. In this
case, allocate the different MAC ID via Keypad.

® \When the option board is in communication with other nodes, NS (Network Status)
LED turns Solid Green.

3.2. When EMC (Explicit Message Connection) is established by
Scanner

® Network Status LED turns green. During this state, if EMC setting is deactivated,
the LED will turn green after 10 seconds delay. Once EMC is connected, I/O
Connection setting is available. At this time, the Network Status LED will not change.
® If I/O Connection is not established within given time, then Time Out will occur
and Network Status LED turns flashing Red. (Depending on the time setting of EMC,
the status can be changed to green again.)
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CHAPTER 4 - TROUBLESHOOTING

The current status of Device and Network can be monitored through built-in LED

(MS, NS).

[NS (Network Status) LED]

LED Status Cause Diagnostics
OFF Off-Line The option card is not Check DeviceNet power and
(No Power) receiving power from the | cable connections and the power
Network. connection on the DeviceNet
terminal block.
Single node on the Check DeviceNet Master node
network operation for correct
Communication.
Incorrect Baud Rate is Change the baud rate setting and
set. reset the inverter.
Flashing On-Line, Communication is set Normal operating status before
Green Not Connected after duplicate node user makes connection.
check is finished, but
connection to other
node is not completed.
Solid On-Line, More than one EMC Polled I/O connection is
Green Connected connection is available.
(Link OK) established.
Flashing Connection Time- | Polled I/O connection is | Inverter Reset.
Red Out Timed Out Request Reset Service to the
Critical Link Inverter Reset Identity Object.
Failure. Retry 1/0O connection.
Solid Red Faults occurred Duplicate MAC ID check | Change the setting of MAC ID.
failed
Bus Off State Check for line connection
Green> Self- diagnostic Device is under self- | Wait for a moment.
Flashing diagnostic mode.
Red
Red > Communication State of Communication | No action required.
Flashing | Fault Fault due to the failure
Green to pass the Network

Access. Identity
communication Fault
Request is accepted
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[MS (Module Status) LED]

LED Status Cause Diagnostics

i ) Check the incoming power to
5V Power is not applied | ) )
Off No Power inverter is provided.

to the option card. _
Check 5V power is ON.

Solid ) )
Operational Normal operation state
Green
Solid Red Unrecoverable Data transaction through | Check the connection between
oli e
Fault DPRAM is disrupted.. option card and Inverter.
Flashing
Device is in self-test
Green & Self Test
mode.
Red

1. EDS(Electronic Data Sheet)
EDS files are specially formatted ASCII files that provide all of the information
necessary for a configuration tool such as the DeviceNet Manager, to access and alter
the parameters of a device. The EDS file contains information on the number of
parameters in a device and how those parameters are grouped together. Information
about each parameter is contained in this file such as parameter min, max, and default
values, parameter data format and scaling and the parameter name and units.
Install EDS files for iP5A to control iP5A parameters using DeviceNet Manager program.
This file can be downloaded from : http://www.Isis.biz or contact your LS representative.




CHAPTER 5 - DEVICENET DATA TABLES

B Message
e R: Read Only
« R/W: Read / Write enable
<Device Profile>
« AC/DC Drives: 0x 02

<Object Model>

Object Class Name Class Code
Identity Object 0x01
Message Router 0x02
DeviceNet 0x03
Assembly 0x04
Connection 0x05
Motor Data 0x28
Control Supervisor 0x29
AC/DC Drive 0x2A
Inverter 0x64
< Ildentity Object>
Class Code 0x01
Instance 1 (All attributes are instance 1)
Attribute ID Attribute Name Access Method
1 Vendor ID R
2 Device Type R
3 Product Code R
Revision R
4 Major Revision (High Byte)
Minor Revision (Low Byte)




Attribute ID

Attribute Name

Access Method

1

5 Status R
6 Serial Number R
7 Product Name R

Service Name

Service Code

Implemented for:

Class Instance
Get_Attribute_Single Ox0E No Yes
Reset 0x05 No Yes
Set_Attribute_Single 0x10 No Yes

! Status Attribute

8 (Recoverable Minor
Bit number 0 (Owned) Other Bits
Fault)
Meaning Connected to the master DPRAM Error Not support




< DeviceNet Object >

Class Code 0x03

Instance 1 (All attributes are instance 1)
Attribute ID Attribute Name Access Method
1 MAC ID *? R/W
2 Baud Rate ° R/W
3 BOI Not support
4 Bus-Off Counter Not support
Allocation Information:
5 Allocation Choice Byte 4 R
Master’s MAC ID

6 MAC ID Switch Changed R
7 Baud Rate Changed Not support
8 MAC ID Switch Value Not support
9 Baud Rate Switch Value Not support

Service Name

Service Code

Implemented for:

Class Instance
Get_Attribute_Single Ox0E Yes Yes
Set_Attribute_Single 0x10 No Yes
Allocate Master/Slave
) 0x4B No Yes
Connection Set
Release Group?2 0x4C No Yes
2 Range of Mac ID: 0 to 63
> Baud Rate
Value 0 1 2
Baud Rate 125 kbps 250 kbps 500 kbps
* Allocation Choice Byte
7 6 5 4 3 2 1 0
Not Supported Polled Explicit Message




Identifier Set

< Assembly Object >

Class Code

0x04

Instance

1 (All attributes are instance 1)

Service Name

Service Code

Implemented for:

Class Instance
Get_Attribute_Single Ox0E No Yes
Set_Attribute_Single 0x10 No Yes
< Output Assembly Data Attribute Format >
Instance | Byte Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
0 Fault Run
Reset Fwd
1
20 .
Speed Reference (Low Byte) — RPM unit
(100) 2
(Speed Reference (Low Byte) — Hz unit)
Speed Reference (High Byte) — RPM unit
3
(Speed Reference (High Byte) — Hz unit)
Fault Run Run
0 NetRef | NetCtrl
Reset Rev Fwd
1
21
Speed Reference (Low Byte) — RPM unit
(101) 2
(Speed Reference (Low Byte) — Hz unit)
Speed Reference (High Byte) — RPM unit
3
(Speed Reference (High Byte) — Hz unit)




Related Attribute
Name Description
Class Attr. ID
Forward Run
Run Fwd 0x29 3
Command
Reverse Run
Run Rev 0x29 4
Command
Fault reset Fault Reset Command 0x29 12
NetRef ° Not used O0x2A
NetCtrl ° Not used 0x29 5
Speed
Speed Command 0x2A 8
Reference

5: 6 Setting Reference Control and Run/Strop Control can Only be done via LCD Keypad. Therefore, NetRef,
NetCtrl in Instance 21 and 101 is not available.



< Input Assembly Data Attribute Format >

Instance | Byte Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
Run-
0 Faulted
ning1
70 !
(110) 5 Speed Reference (Low Byte) — RPM unit
(Speed Reference (Low Byte) — Hz unit)
3 Speed Reference (High Byte) — RPM unit
(Speed Reference (High Byte) — Hz unit)
Ref Ctrl Run- Run-
0 R'A‘;tf from from Ready | ning 2, | ning 1, Wif]m_ Faulted
' Net Net (Rev) (Fwd) 9
71 !
(111) 5 Speed Reference (Low Byte) — RPM unit
(Speed Reference (Low Byte) — Hz unit)
3 Speed Reference (High Byte) — RPM unit
(Speed Reference (High Byte) — Hz unit)
L. Related Attribute
Name Description
Class Attr. ID
Faulted DPRAM or Inverter 0x29 10
Error
Warning Not Supported 0x29 11
Running1 Motor is running 0x29 7
Forward
Running2 Motor is running 0x29 8
Reverse
Ready Motor is ready to run 0x29 9
Ctrl From Net Run/Stop control 0x29 15
Ref From Net Speed control Ox2A 29
At Reference Reach at Reference Ox2A 3
Speed
Drive State Current Motor State 0x29
Speed Actual Speed Command 0x2A 7




< Connection Object >

Class Code 0x05
1 Predefined EMC
Instance 2 Poll 1710
6,7,8,9, 10 Dynamic EMC
Access Method
Attribute . 110 EMC
ID Attribute Name Established/ Established/
Timed Out Deferred delete
1 State R R
2 Instance_type R R
3 TransportClass_trigger R R
4 Produced_connection_id R/W R
5 Consumed_connection_id R/W R
6 initial_comm_characteristics R R
7 Produced connection_size R R
8 Consumed_connection_size R R
9 Expected_packet_rate R/W R/W
10 — 11 N/A
12 Watchdog_timeout_action R/W R/W
13 Produced_connection_path_ length R R
14 Produced connection_path R R
15 Consumed_connection_path_ R R
length
16 Consumed_connection_path R R
17 Production_inhibit_time R/W R
Service Name Service Code Implemented for:
Class Instance
Get_Attribute_Single Ox0E No Yes
Reset 0x05 No Yes
Set_Attribute_Single 0x10 No Yes




< Motor Data Object >

Class Code 0x28
Instance 1 (All attributes are instance 1)
Attribute ID Attribute Name Access Method
3 MotorType R’
6 RatedCurrent R/W
7 RatedVoltage R

! MotorType Attribute Squirrel Cage Induction Motor: #7

Service Name Service Code Implemented for:
Class Instance
Get_Attribute_Single Ox0E No Yes
Set_Attribute_Single 0x10 No Yes
< Control Supervisor Object >
Class Code 0x29
Instance 1 (All attributes are instance 1)

Attribute ID | Attribute Name Access Method
3 Run 1 (Forward command) R/W
4 Run 2 (Reverse command) R/W
5 NetCtrl ° R
6 State R
7 Running1 (Forward running) R
8 Running2 (Reverse running) R
9 Ready R
10 Faulted R
12 FaultRst R/W
13 FaultCode R
15 CtrIFromNet R

¥ NetCtrl Attribute: This Attribute setting determines the control location for the motor. This value
only can be set through the keypad for the safety reason. Changing this via DeviceNet does not cause
error and cannot affect the setting



Service Name

Service Code

Implemented for:

Class Instance
Get_Attribute_Single Ox0E No Yes
Set_Attribute_Single 0x10 No Yes
< AC/DC Drive Object >
Class Code 0x2A
Instance 1 (All attributes are instance 1)
Attribute ID Attribute Name Access Method
3 AtReference R
4 NetRef® R/W
6 DriveMode R/W
7 SpeedActual R
8 SpeedRef R/W
9 CurrentActual R
29 RefFromNet R
100 Actual Hz R
101 Reference Hz R/W
102 Acc. Time R/W
103 Dec. Time R/W

? NetRef Attribute

This setting is only done via Keypad for safety reason.

error and cannot affect the setting.

Changing this via DeviceNet does not cause

Service Name

Service Code

Implemented for:

Class Instance
Get_Attribute_Single Ox0E No Yes
Set_Attribute_Single 0x10 No Yes




< Inverter Object >

Class
0x64 Attribute Number
Code
1 DRV Group iP5A Parameter code # + 1
2 FU1/FU2 Group Same as iP5A Parameter code #
Instance 3 /0 Group Same as iP5A Parameter code #
4 COM Group Same as iP5A Parameter code #
5 APP Group Same as iP5A Parameter code #

Note) Refer to iP5A inverter manual for reference of Attribute Number. It is the same as iP5A

Parameter Code Number.

Service Implemented for:
Service Name
Code Class Instance
Get_Attribute_Single Ox0E Yes Yes
Set_Attribute_Single 0x10 No Yes




CHAPTER 6 - PARAMETER CODE (HEX)

<iP5A 2 5HY>"

Parameter . Read/
Parameter Name Unit Data Value (Hex)
Address Write
0x0000 Inverter model - R 9: SV-iP5A
SV-iP5A
4:5.5 5:7.5 6:11 7:15
8:18.5 9:22 A:30 B:37
0x0001 Inverter capacity - R C:45 D:55 E:75 F:90
10:110 11:132 12:160 13:220
14:280 15:315 16:375 17:450
(Unit @ kW)
0x0002 Inverter Input Voltage - R 0: 220V Class 1: 440V Class
0x0003 S/W Version - R Ex) 0x0100:Ver1.00, 0x0110:Ver1.10
0x0005 Frequency Reference 0.01Hz R/W
Bit0O Stop
Bit01 Forward run (FX)
R/W B!t02 Reverse run (RX)
Bit03 | Fault reset(0—1)
Bit04 Emergency stop
Bit05 Not used
Bit06 oo 3 0 Terminal
© 3 3 1 Loader
£ 30 i
Bit07 s & 5 2 Option
3 Int. 485
Multi-step
0~16 speed freq.
Bit08 (0, 2~16)
UpDown
0x0006 Run Command - T 17~19 (Up,Down,
D
o UDZero)
c
CjD 20~21 Not used
R Bit09 2 505 Analog
3 (V1,V1S,1,v1l)
o 26 Pul
Bit10 e se
5 27 Sub
@]
® P 4
Bit1 1 8 Int 85
29 Option
Bit12 50 JOG
31 PID
Bit13 Not used
Bit14 Not used
Bit15 Set when Network error




Parameter Read/
e Parameter Name Unit O Data Value (Hex)
0x0007 Acceleration Time 0.1 sec R/W
0x0008 Deceleration Time 0.1 sec R/W
0x0009 Output Current 0.1 A R
0x000A Output Freguency 0.01 Hz R
0x000B Output Voltage 0.1V R
0x000C DC Link voltage 0.1V R
0x000D Output power 0.1 kW R
Bit00 Stop
Bit01 Forward running (FX)
Bit02 Reverse running (RX)
Bit03 Fault (Trip)
Bit04 Accelerating
Bit05 Decelerating
Bit06 Speed arrival
0x000E Operating status of ~ . Bit07 Forward run command
Inverter Bit08 DC Braking
Bit09 Not used
Bit10 Brake Open
Bit11 Forward run command
Bit12 Reverse run command
Bit13 REM.R/S(Int. 485,0PT)
Bit14 REM.Freq.(Int. 485,0PT)
Bit15 Not used
Bit0O0 OCT1
Bit01 oV
Bit02 EXT-A
0x000F Trip information - R Bitos B
Bit04 LV
Bit05 Not used
Bit06 GF (Ground Fault)
Bit07 OH (Inverter overheat)




Parameter Read/

e Parameter Name Unit S Data Value (Hex)
Bit08 ETH (Motor overheat)
Bit09 OLT (Overload trip)
Bit10 HW-Diag
Bit11 Not used
Bit12 0OCT2
Bit13 OPT (Option error)
Bit14 PO (Phase Open)
Bit15 IOLT
Bit0O0 M1
Bit01 M2
Bit02 M3
Bit03 M4
Bit04 M5

0x0010 Input terminal status - R BItos MO
Bit06 M7
Bit07 M8
Bit08 P4
Bit09 P5
Bit10 P6
Bit11~15 Not used
Bit0O0 AUX1
Bit01 AUX2
Bit02 AUX3
Bit03 AUX4

0x0011 Output terminal status - R Bit04 Q1 (0OC1)
Bit05 Q2 (0C2)
Bit06 Q3 (0C3)
Bit07 30AC
Bit8~15 Not used

0x0012 V1 - 0 ~ FFCO

0x0013 V2 - 0 ~ FFCO

0x0014 I - 0 ~ FFCO




Read/

Parameter
Parameter Name Unit Data Value (Hex)
Address Write
0x0015 RPM - R
0: Hz,
O0x001A Unit display - R
1: RPM
0x001B Pole number -
0x001C Custom Version -

% When you modify data through the common parameters, the data is not saved. The

modified data is applied only at the present time, but the data will revert to the previous

value in case of the inverter’s reset or its power Off/On again. When you modify data

through the group parameters except the common, the modified value is applied even if

the inverter’s reset of its power Off/On.




6.1 COM Group Parameters (Parameter’s addresses are hexadecimal)

CODE Adj.
Comm. Add LCDKeypad Factory
Description Setting Range During
COM Display Default
Run
00 9600 Jump to Desired Code # Jump code 1 -67 1 O
01 9601 Type of the option board Opt B/D DeviceNet * *
None
02 9602 Option mode Opt mode Eggma“d None X
Cmd + Freq
03 9603 Option version Opt Version Ver X. X Ver X. X *
10 960A DeviceNet ID MAC ID 0-63 63 O
(125 kbps)
DeviceNet communication
11 960B Baud Rate (250 kbps) 125 kbps O
speed
(500 kbps)
(20)
(21)
12 960C DeviceNet output instance |Out Instance ( ) 20 O
100
(101)
(70)
(71)
13 960D DeviceNet input instance In Instance ( ) 70 O
110
(111)
Update option parameters No
67 9643 Comm UpDate No X
of communication Yes

® COM-01 [Opt B/D]

Indicates Option boards installed. This value is automatically set when the boards are installed.

® COM-02 [Opt Mode]

Determines whether Run/Stop/Reference Frequency is set via Communication.

Value Display Description

0 None Disabled

1 Command Run/Stop setting via Communication

2 Freq Frequency setting via Communication

3 Cmd + Freq Run/Stop/Reference Frequency via Communication




COM-03 [Opt Version]

Displays version of Option Board.

COM-10 [ MAC ID ]
Set up a MAC ID of DeviceNet. MAC ID should be a unique value in the network. If a MAC
ID has a duplicate value in the network, NS (Network Status) LED is turned on red to

display the status.

COM-11 [ Baud Rate ]
Set up the communication speed of the DeviceNet. Communication speeds should be same

in one network.

COM-12,13 [ Out Instance, In Instance ]

This is the parameter that is used in the Assembly Object of the DeviceNet.

(Assembly Object: It is the object to monitor an inverter’s output frequency and run status
(In Instance) when an inverter’s run command and a frequency command (Out Instance)

are entered.)

COM-67 [ Comm UpDate ]
It is used to update the communication parameters which have been changed. It is the

parameter only for the iP5A.
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